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3. You can create a new transcript using either of the following
methods:

■ Click the New Transcript button on the toolbar at the bottom of
the LiveNote window. 

■ From the Transcript menu, choose New. 

The New Transcript Properties dialog box is displayed.

4. Type Simulation in the Name text box and click OK. A new, blank
transcript is displayed.

Connecting to a Simulated 
Real-Time Transcript
LiveNote is software that allows you to view and work with deposition transcripts. When LiveNote is installed, it provides you
with a demonstration case, which includes sample deposition transcripts, exhibits, preset issues, and the simulation of a real-time
deposition. You can use the simulated transcript to practice using the basic tools of LiveNote. To access the simulation, you must
create a new transcript that can receive the simulated transcript and then connect to the simulated transcript.

Creating a New Transcript
To create a new transcript, complete these steps:

1.Access LiveNote. 

2. When the Open Case dialog box is displayed, select Demonstration Case and click OK. The case window is displayed. It lists
all the transcripts for the case.

Connecting to the Simulated Transcript
To connect to the simulated transcript, complete these steps:

1. Click the Connect button on the toolbar at the bottom of the
LiveNote window to display the Connect to Realtime dialog box.

2. Select Simulation and click Connect. The deposition automatically
begins transcribing in the transcript window.
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Connecting to LiveNote in Real-Time 
Connecting via a Serial Connection

You can connect to a LiveNote session in real-time using serial cables.
LiveNote cabling requires a serial port on your computer. If you have only a
USB port available, you will need to provide a USB to serial adapter. If a USB
to serial adapter is not available, you can connect to the LiveNote session over
the Internet via LiveNote StreamTM. The court reporter must notify LiveNote 24
hours in advance if you want to use LiveNote Stream.  

To connect to a real-time session using serial cables, complete these steps:

1. Open a new transcript. 

2. Click the Connect button on the toolbar at the bottom of the LiveNote
window to display the Connect to Realtime dialog box.

3. Select Serial. The court reporter will give you the necessary  settings for
connecting to the reporter’s CAT (computer–aided transcription) system.
You will need to know the required serial port setting. 

4. Click Connect to connect to the real-time session.

Connecting via the Internet
LiveNote Stream allows you to connect to a LiveNote real-time session via the Internet. Contact West Court Reporting Services
24 hours in advance to schedule the session. LiveNote will send you an e-mail with the required username and password. To
connect to a LiveNote Stream session, complete these steps:

1. Open a new transcript. 

2. Click the Connect button on the toolbar at the bottom of the LiveNote window to display the Connect to Realtime dialog
box.

3. Select LiveNote Stream and click Connect to display the Login dialog box. 

4. Type the username and password sent to you by LiveNote and click OK to display the Sessions dialog box. 

5. Select the session you want to attend and click OK.
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LiveNote Basic Tools
LiveNote provides you with tools that are easy to use even when you are working with a real-time transcript in a live deposition.
You can stop and start the scrolling text, annotate the text, and do quick word searches at the same time that you are listening
to what the deponent is saying. You can also annotate and search existing transcripts.

Starting and Stopping Text
To stop the scrolling real-time transcript while in a deposition, press the Esc key or click the Stop button on the toolbar at the
bottom of the LiveNote window. The line currently being transcribed is completed and the scrolling transcript pauses.

To browse the text of the transcript, you can use the scroll bar on the right or press the Page Up and Page Down keys or the
arrow keys on your keyboard. Pressing Ctrl+Home will take you to the top of the text; pressing Ctrl+End will take you to the
end of the text.

To restart the scrolling transcript, press the Esc key or click the Continue button on the toolbar at the bottom of 
the LiveNote window.

Using Quick Marks
Quick Marks are marks at the line number in the margin of a transcript. They are the simplest form of annotation in LiveNote
and are displayed as a solid bar in the default Quick Mark color. You can use them as place markers in the text for which you
can run searches and generate reports. To insert a Quick Mark, press the spacebar on your keyboard or click a line number. 

A complete list of all Quick Marks in a transcript is located in the Quick Marks folder under the transcript in the case window.
Click the Quick Marks folder to open it. Double-click a Quick Mark reference in the folder to jump to the Quick Mark in the
transcript.

To delete a Quick Mark, click it in the margin of the transcript.

Press the spacebar or click a
line number to place a Quick
Mark in the margin of the
transcript.

Double-click a Quick Mark
reference in the Quick Marks
folder to jump to its location
in the transcript. 
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Using Issue Marks
An Issue Mark is a mark at the line number in the margin of a transcript that corresponds to a particular issue on the Issue bar.
The Issue Mark color is the same as the color of the issue. To insert an Issue Mark, press the number key on your keyboard that
corresponds to the number assigned to the issue on the Issue bar.

A complete list of all Issue Marks is located in both the Quick Marks folder and the Issues folder in the case window. You can
view the issues by category in the Issues folder. Click the Quick Marks or Issues folder to open it. Double-click an Issue Mark
reference in the folder to jump to the Issue Mark in the transcript. 

To delete an Issue Mark, click it in the margin of the transcript.

Press the number key that
corresponds to the number
associated with the issue on
the Issue bar to place an
Issue Mark in the margin of
the transcript.

Double-click an Issue Mark
to jump to its location in the
transcript. 

Adding Annotations Using the Issue Bar
An annotation is a highlighted portion of the transcript text. It may be associated with an issue, a note (a comment associated
with an annotation), or an attachment, e.g., a document or image. To add an annotation associated with an issue using the Issue
bar, complete these steps:

1. Click the Auto Annotation button (      ) on the Issue bar to cancel its selection. 

2. Click an issue button on the Issue bar to select the
issue and assign it to the annotation you are adding.

3. Select the text you want to annotate. The text is
highlighted with the color of the issue you selected.
The issue will be assigned to every annotation you
create until you cancel its selection on the Issue bar.

Note: You can select more than one issue from the Issue bar. The annotated text will be highlighted with the color of the issue
that is first in alphabetical order.
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Adding Annotations Using the Annotate Dialog Box
To add an annotation associated with an issue, note, attachment, or a combination of these, complete these steps:

1. Make certain the Auto Annotation button (      ) on the Issue bar is selected. (This is the default setting.)

The annotated text is highlighted with the color of the issue you select. If you do not select an issue, the text is highlighted
with the default annotation color.

2.  Select the text in the transcript you want to annotate. The Annotate dialog box is displayed. 

3.  The Issues tab in the Annotate dialog box displays the prioritized list of issues. Note that the check boxes for any issues you
previously selected on the Issue bar are already selected. To assign one or more issues to the annotation, select the
appropriate check boxes. If an issue has not been prioritized (does not
appear on the Issue bar), it is listed in the Other list box. To assign a non-
prioritized issue, select it in the Other list box. To prioritize the issue, right-
click it and drag it next to a number. 

4.  To add a note to the annotated text, click the Note tab and type your note
in the text box.

5.  To add an attachment to the annotated text, click the Attachment tab. You
can add any type of file that can be opened on your computer. Click
Browse to display the Find Attachment dialog box. Select your document
and click Open. When you add an attachment, a paper clip icon (      ) is
displayed in the margin next to the annotated text. 

6.  Click OK to save the annotation. 

Creating Reports for Quick Marks, Issue Marks, or Annotations
To create a report for Quick Marks, Issue Marks, or annotations, right-click the folder in the case window for which you want
to create the report, e.g., Issues. Click View Report to display your report, which includes the line you marked and the
surrounding question and answer. 

To generate a report using all transcripts, click Transcripts at the top of the report to display the Report Transcripts dialog box.
Click Select All, then click OK. 

To restrict your report to a particular issue, click Issues at the top of the report to display the Report Issues dialog box. All issues
are automatically selected. To remove an issue from the report, clear its check box or cancel its selection in the Other list box.
Click OK.

To return to the location in the transcript where the mark appears, double-click its section in the report or choose the transcript
from the Window menu. 

To return to the report from the transcript window, press Ctrl+Tab or choose it from the Window menu. New annotations are
automatically added to the report as you create them, so the report is always current.

Right-click the Issues folder,
then click View Report to
create an Issues report.
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Using the Word Wheel
Use the Word Wheel to search for a word in the transcript. Type the word in the text box on the left side of the LiveNote
window to display the pages and lines where the word is found in the transcript. 

To see the word in context, hold your pointer over the page and line reference. The question and answer in which the word
appears is displayed.

To display the word in the transcript, click the page and line reference.

Type the word you want to
search for in the Word
Wheel text box.

Hold your pointer over the
page and line reference to
see your word in context.

Click the page and line
reference to view your word
in the transcript.

Creating Auto Tags
Use Auto Tags to automatically highlight words or phrases as they appear in the transcript. Click the Auto Tags button on the
toolbar at the bottom of the LiveNote window to display the Auto Tags dialog box. 

For each word or phrase you want to add, complete these steps: 

1. Click Add to display the Add Keyword dialog box.

2. Type the word or phrase you want to add to the Auto Tags list. You can use the asterisk (*) at the beginning or end of a word
to include variations of the word. Then click OK. The word or phrase is added to the list in the Auto Tags dialog box. 

3. Select the Show Auto Tags check box to highlight Auto Tags in transcripts.

4. Click OK to save your changes. Your Auto Tags will be highlighted automatically throughout the transcript. 

Auto Tags dialog box Add Keyword dialog box Transcript with highlighted Auto Tags

To create an Auto Tags report, from the Report menu, choose Auto Tag Query.
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Using Full Text Query
Use Full Text Query to search for a phrase in the transcript. Click the Full Text Query button on the toolbar at the bottom of
the LiveNote window. The Full Text Query dialog box is displayed. Type the phrase in the Query text box and click OK. The
search is automatically run in all transcripts. The result is displayed in the Query window on the lower-left side. Click a
transcript folder to see a list of the places in the transcript where the phrase appears. Click Report to view your phrase in
context.

Type the phrase you
want to search for in
the Query text box.

Click Report to
see your phrase
in context.

Updating Transcripts
LiveNote transcripts can be updated using ASCII files (text only files, usually received from the court reporter), PTF files (files
containing text and annotations, usually received from another LiveNote user), or LEF files (files containing transcripts, exhibits,
exhibit links, and possibly synchronized video). Any annotations, including Quick Marks and Issue Marks, are automatically
transferred to the updated transcript. 

To update your transcript, right-click the transcript in the case window and choose Update from the menu, or select the
transcript and click the Update Transcript button on the toolbar at the bottom of the LiveNote window, to display the Update
Transcript dialog box. Select the new file that has been sent to you and click Open. Select Replace existing text with new text
and click OK. A second, updated file is created. To delete the old file, right-click the draft file and choose Delete from the menu.
Hold down the Shift key and click OK in the Delete Transcript dialog box.

Note: No work product will be lost when you update a transcript. All annotations are linked to the transcript text, not to the
page and line references, so annotations and Quick Marks made in the old transcript are simply transferred to the same text
location in the updated transcript.

Transferring Transcript Text Using the LiveNote Clipboard
Use the LiveNote clipboard to copy transcript text from LiveNote and paste it into other applications. The following details are
transferred with the text:

■ name of the transcript

■ page number (or numbers if copied text spans more than one page)

■ line numbers

To transfer transcript text, complete the following steps:

1. Click the Copy to Clipboard button (     ) on the Issue bar to select it.

2. Click the Auto Annotation button (      ) on the Issue bar to cancel its selection.

3. Select the text you want to copy. 

4. Open another application and paste the text you have copied. For example, to paste the text into Microsoft Word, press
Ctrl+V or choose Paste from the Edit menu.
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Creating Issues
To create a new issue, complete the following steps:

1. From the Issue menu, choose New to display the New Issue dialog box.

You can also drag an issue in the All Issues list box to a text box. 

Issue bar

To prioritize an issue and add it to the Issue bar, complete the following steps: 

1. From the Issue menu, choose Current to display the Current Issues dialog box.

2. Click the arrow in the first text box to display the list of issues. 

3. Select an issue, e.g., Photograph. This issue is assigned to the number 1 in the priority list and is added to the Issue bar.

4. Repeat steps 2 and 3 for each issue. You can prioritize up to 10 issues. Click OK when you finish prioritizing the issues. 

Prioritizing Issues

2. Type the name of the issue in the Issue text box, e.g., Employment History.

3. Select the Redisplay Dialog check box if you are creating
multiple issues.

4. Click Change to display the Color dialog box.

5. Select a color and click OK.

6. Click OK in the New Issue dialog box.
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